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Overview
Shape Sculptor Version 5 application is a new powerful product enabling users to quickly create, edit, 
modify and sculpt polygonal models. Within Shape Sculptor, a scanned model can be imported and 
quickly edited to add details and new features. Polygonal models can also be created by tessellating 
existing surface models or generated from 3D curves. With its powerful and intuitive polygonal 
modeling tools, new features and details can be added to the polygonal model. 

Thanks to its ease of use, Shape Sculptor is the perfect tool to rapidly edit and sculpt polygonal 
models and complements surface-based conceptual modeling tools when surfacing becomes too 
complex. 

Shape Sculptor can be used with other curve and surface-based modeling tools, including Generative 
Shape Design, FreeStyle and Automotive Class A and also in cooperation with other polygonal 
products including Digitized Shape Editor, STL Rapid Prototyping and Quick Surface Reconstruction.

 

Using This Guide
Where to Find More Information
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Using This Guide
This book is intended to help you become quickly familiar with the Shape Sculptor product. You 
should already be accustomed with basic Version 5 concepts such as document windows, standard 
and view toolbars. 

To get the most out of this guide, we suggest that a beginning user reads the Getting Started 
chapter first of all and the Workbench Description to find his way around the Shape Sculptor 
workbench. 

The next sections present the main capabilities in the form of basic and advanced user's tasks. It 
may be a good idea to take a look at the section describing the workbench menus and toolbars. 
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Where to Find More Information
Prior to reading this book, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all products. It also describes the general layout, and 
interoperability between workbenches. 

The Generative Shape Design, FreeStyle, Automotive Class A, Digitized Shape Editor, STL Rapid 
Prototyping and Quick Surface Reconstruction documentations may prove useful.

See also the Conventions.
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What's New?
The documentation will be available on the R13 SP2 level.

New Functionalities

Extracting Curves

Optimal CATIA PLM Usability for Shape Sculptor
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Getting Started
Before getting into the detailed instructions for using CATIA Shape Sculptor, the following tutorial 
aims at giving you a feel of what you can do with the product. It provides a step-by-step scenario 
showing you how to use key functionalities. 

The main tasks described in this section are: 

This tutorial should take about 10 minutes to complete. 

Entering the Workbench
Importing a Polygonal Mesh
Decimating a Polygonal Mesh

7Page Shape Sculptor Version 5 Release 13



Entering the Workbench

The first task will show you how to enter the Shape Sculptor workbench.

The only pre-requisite for this task is to have a current CATIA V5 session running.

1.  Select Shape Sculptor from the Start -> Shape menu.

The Shape Sculptor workbench is displayed and ready to use.

 The workbench looks like this:
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You may add the Shape Sculptor workbench to your Favorites, using the Tools -> Customize 
item. For more information, refer to the Infrastructure User's Guide.

If you wish to use the whole screen space for the geometry, remove the specification tree 
clicking off the View -> Specifications Visible menu item or pressing F3.
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Importing a Polygonal Mesh

This task shows how to import digit files describing a cloud of points (scanned or computed) 
or a polygon. 

1.  Click  the 

Import icon 

. 

The Cloud 

Import dialog 

box is 

displayed.

 

2.  In the Selected File area, use the button ... to browse your directories and select a 

file.

3.  Click Apply and OK to finish the import of the polygonal mesh.
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Decimating a Polygonal Mesh

This task shows you how to decimate a polygonal mesh, in order to reduce the triangle count of a polygon. 

Open the Bunny1.CATPart document.

1.  Click the Decimation icon  and 

select a polygonal mesh. 

The dialog box is displayed.

 
2.  Check the type of decimation you want to apply: 

●     Chordal Deviation, or

●     Edge Length

 
3.  Click Apply. 

The decimation is computed. The 

counts of triangles are updated in the 

Current Triangle Count.

11Page Shape Sculptor Version 5 Release 13



 
4.  Either press OK to validate the decimation and exit the action,

or press Apply to start continue the decimation with the same values or new ones,

or press Cancel to exit the action and revert to the initial model
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User Tasks
Input / Output

Selecting Components
Creating
Editing

Modeling
Analyzing

Interoperability with Wireframe
Generic Tools
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Input / Output
Importing Files

Exporting to STL
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Importing Files
 

This task shows how to import digit files describing a cloud of points (scanned or computed) or a mesh. 

Use the MultiImport1.cgo_ascii, MultiImport2.cgo_ascii, MultiImport3.cgo_ascii from the samples directory.

Available formats depend on the workbench you are working in.

Digitized Shape Editor 
●     Ascii free,

●     Atos (the quality of the points can be taken into account),

●     Cgo,

●     Gom-3d (as points, scans, grids or meshes, the quality of the points can be taken into account),

●     Hyscan,

●     IGES (IGES Entities 116 are processed. If the cloud to import is made of Entities 116 only, the result is a cloud of points. Otherwise, the result is made of scans).

●     Kreon

●     Steinbichler (as points, grids or scans),

●     Stl (bin or ascii, with creation of free edges and facets, if requested).

 

STL Rapid Prototyping 
●     STL files (bin or ascii, with creation of free edges and facets, if requested) (default option),

●     Cgo,

●     Ascii free,

●     IGES (IGES Entities 116 are processed. If the cloud to import is made of Entities 116 only, the result is a cloud of points. Otherwise, the result is made of scans).
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●     In Cgo, Ascii and IGES formats, you can not process more than 10,000 points at each import, in one or several files, e.g. you can not import 4 files of 3,000 points each in one 
shot but you can import them separately.

●     This limitation applies to the input files (before Sampling or resizing with the bounding box).

●     If you try to import over 10,000 points in one shot, a fatal error panel is displayed: Too many points for this configuration.
❍     If the Grouped option is active, no file is imported.

❍     If the Grouped option is not active, files are imported as long as the sum of their points does not exceed 10,000 points.

●     Mesh Regeneration is not available on those files.

 

Shape Sculptor
●     STL files (bin or ascii, with creation of free edges and facets, if requested).

 

1.  Click  the Import icon . The Cloud Import dialog box is displayed.

2.  In the Format field, select the file format.

3.  In the Selected File area, use the button ... to browse your directories and select a file.

4.  Check the box Statistics to display information about the model you are importing. If you want to import several files in one shot, please refer to the Grouped explanations. 

5.  In the Options field:

●     Enter the Sampling percentage to apply; 

The sampling value determines the percentage of points or scans or grids that will be read from the digit file.

●     Enter the Scale factor to apply to the model, as well as the Unit used in the file.
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●     If the extension of the file you have selected is consistent with the list proposed, the Format field is updated automatically. Otherwise, be careful to enter the correct format in 
that field.

●     Once you have performed an import operation, V5 proposes the last entered file path and format as default. If you click on ..., the last entered directory is proposed as default.

●     The File unit option is not relevant to the Steinbichler format, nor the Sampling percentage to the Stl format.

6.  For some digit file formats, you may want to enter additional data that are displayed by clicking the button More>>
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For Ascii: For Atos and Gom-3d: For Iges: For Stl:

Direction and Delimitors apply to scans. Enter these data whenever you know them.

Minimal Point Quality is used to clean Atos file from invalid points. The quality value of a point lies between 0 and 255 (low to high). Choose a value to ignore points 
below that value:

●     Minimal Point Quality value is 125:

  

●     Minimal Point Quality value is 75:

System  applies to the operating system (Unix or Windows NT) used to generate the binary data: select Same if you know you are using the same operating system as the 
one used to generate the binary data, Other for the other way, Unknown if you have no indication.
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Free Edges is used to create or not the scans representing the free edges of a mesh:

or 

Facets is used to create or not the facets of the imported mesh:

 or 

7.  Click Apply to display the cloud of points or mesh:

8.  Push the button Update to display the bounding box of the cloud of points or mesh. Use the green arrow to resize it in order to import only a part of the cloud of points or 

mesh. 
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●     The bounding box appears every time the cursor passes over a cloud of points or a mesh. Its size corresponds to that of the visible points. 

●     If a local axis system is set as current, the file will imported in this axis systems and not in the absolute axis system as previously. If no local axis system is set as current, the file 
will be imported in the absolute axis system. 

●     Moreover, if a local axis system is set as current, the axis system of the dynamic box used to select a portion of the imported file when the Update button is pushed is parallel to 
the local axis system axis. 

The check box Replace is used to replace the current cloud of points or mesh by a new one.
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9.  Once you are satisfied with the preview, click Apply and OK to finish the import of the cloud of points or mesh.

●     The name of the element created in the specification tree is the name of the original file, without its extension.

●     Undo and Redo are available.

●     V5 memorizes the data of the last imported file and proposes them at the next import action.

Importing a Set of Files

1.  Click  the Import icon . The Could Import dialog box is displayed. The operating mode is the same as for one file.

The files to import must: 
●     have the same format,

●     be located under the same directory.
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The Selected File field looks like this: 

If you check the Grouped option (this is the default status):

All the files are imported as one single cloud of points instead of several:

If you do not check the Grouped option: 

The files are imported separately.

 

The three digit files have been imported together, resulting in one cloud of 
points or mesh.

  

 

The three digit files have been imported separately, resulting in three clouds of points. 

 
One  cloud of points Element Cloud Import.x is created in the specification 
tree, with the icon of the Import command.

One cloud of points element is created in the specification for each input file, with the icon of the 
Import command and the name of the input file  (MultiImport1.1, MultiImport2.1, 
MultiImport3.1) .

●     You can also merge several clouds of points into one whenever necessary, using the Merge Clouds command.
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Exporting Polygons to STL 

This task shows how to export a  mesh to binary Stl format.

Open the Cloud.CATPart from the samples directory.

1.  Select the Polygon.1 and then the export icon . 

The export dialog box is displayed.

2.  One export format is available: Stl.

3.  Browse your directories and enter the target directory and file name. Then click Save.

 

●     The selection is exported with the current local axis system if any, with the absolute axis 
system otherwise.

●     You can export only one element at a time.

●     In STL Rapid Prototyping, only the Stl format is available.
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Selecting Components
Selecting With a Brush
Selecting With Curves

Selecting Holes
Selecting With Flood

Inverting the Selection
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Selecting With a Brush

This task shows how to select triangles from one or multiple polygonal meshes using a brush.

Open the Bunny1.CATPart document.

1.  Click the Brush Select icon .

The Brush Select dialog box displays.

 

 
2.  Define radius to increase or decrease the brush size.

3.  Drag the brush over the polygonal mesh to select triangles.

4.  Click OK.

You may modify the size of the brush during the selection, simply:
●     use the Ctrl key to add triangles to the selection, or

●     use the Shift key to remove triangles from the selection.
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Selecting With Curves

This task shows how to select triangles from the polygonal mesh using curves.

Open the Pin2.CATPart document.

1.  Click the Curve Select icon .

 
2.  Select the curves delimiting the area to select.

 

 
3.  Click inside in this area to delimit it using the selected curves.
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●     Selecting several curves can be done holding the Ctrl key.

●     Selecting a curve loop enables the selection of all triangles inside this loop.
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Selecting Holes

This task shows how to select surfaces boundaries of a polygonal mesh.

Open the Felix2.CATPart document.

1.  Click the Hole Select icon .

Holes, that is the boundaries of the polygonal mesh, become visible.

 

 
2.  Move the mouse onto a hole and select it.
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 The hole is highlighted and put in the selection list.
 

30Page Shape Sculptor Version 5 Release 13



●     If you hold the Ctrl key while selecting the holes, the latter are appended to the selection. 

Otherwise the selection is automatically cleared before a new one is made.

 
●     Once holes are selected, you can activate any other command.

For instance, you can use the Stitching command to stitch the polygonal mesh along the 
selected holes. 
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Selecting With Flood

This task shows how to quickly select triangles that are topologically connected to the selected 
triangle.

Open the Pin1.CATPart document.

1.  Click the Flood Select icon .

 
2.  Click on a triangle of the polygonal mesh.

All triangles that can be reached from this initial triangle are selected.

 
 

 Selecting a curve enables to extend the selection to all the connected curves (continuous in 
point).
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Inverting the Selection

This task shows how to reverse the selection of triangles.

Open the Pin2.CATPart document.

1.  Select triangles using curves as shown in the Selecting Using Curves chapter.

 

 
2.  Click the Invert Select icon .

 The selection of triangles is inverted from the current selection.
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Creating
Creating Associative 3D Curves

Creating Paint Curves
Generating Meshes

Tessellating
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Creating Associative 3D Curves 
This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points 
or passing points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element 
and the later is modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> 
Options -> Mechanical Design -> Assembly Design -> General tab.

  
 

●     Selecting 3D points

●     Editing

●     Keeping a point

●     Imposing a Tangency Constraint

●     Imposing a Curvature Constraint

●     Setting as Arc Limit

●     Removing a Point

●     Constraining a Point

  

Open a new .CATPart document.

1.  Click the 3D Curve icon .

The 3D curve dialog box is displayed.

2.  Choose the curve creation type.

Whatever the chosen type, the curve is previewed in 
dotted line as you move the pointer.

●     Through points: the resulting curve is a multi-arc curve 
passing through each selected point.

   

●     Control points: the points you click are the control points 

of the resulting curve
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●     Near points: the resulting curve is a single-arc, with a set 
degree and smoothed through the selected points.

 

You can edit the order by right-clicking the 
displayed text (displayed using the U, V Orders icon 

 from the FreeStyle Dashboard or the Order 

option from Tools -> Options menu, Shape -> 
FreeStyle -> General tab), and choosing a new 
order value.

The Automatic order option enables you to automatically 
compute an order that will respect at best all the curve 
constraints.
The computed value is displayed near the Auto tag.

   

●     The Deviation option enables the user to set the 
maximum deviation between the curve and the 
construction points.

The result is a set degree through the selected 
points.

●     The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points 
and are inserted into the curve automatically.
The minimum value is set to 1.

●     Smoothing options are now available to parameterize the 
curve:  
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●     Chord Length (default parameterization)
Smoothing parameter = 0

●     Uniform
Smoothing parameter = 0

 
●     Smoothing parameter: enable a better control 

points distribution of the smoothed curve.
 

 

 Smoothing parameter = 50 Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.

  

3.  Move the pointer over a point.

A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.

A contextual menu proposes several options to construct the 3D curve.

Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the 
Tuner dialog box and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency 
constraint on the curve at this point. 

 
4.  Click the Insert a point icon  within the dialog 

box.

The curve freezes.

5.  Click the segment, between two existing points where 

you wish to add a new point and click the point 

location.

 

Once the point has been created, you are back to 
the edition capabilities on the curve.
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6.  Click the Remove a point icon  within the dialog 

box, and select one of the existing points.

The curve is recomputed immediately without the 

selected point.

7.  Click the Free or constrain a point icon  within the dialog box, then select the point.

●     If the point is a point in space (free), move the pointer 

close to the point or a wire to which it should be linked. 

You can then move the pointer over a geometric element 

and: 

❍     move the point to the indicated point by clicking

❍     press and hold the Control  key (Ctrl) to project this 

point onto this element according to the shortest 

distance from the point initial location.

●     If the point was lying on another point or a wire (curve, 

line, spline, and so forth), it is freed from its constraint 

onto this element, and can be moved to any new location 

in space.

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but 
not constrained. It can be moved using the manipulators. 

8.  Click OK to create the curve.

A 3DCurve.xxx appears in the specification tree.

●     Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●     You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point 
where the end point lies, then move the end point to a new location.

●     The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. 
Therefore you can change creation planes within the same curve, by setting a new current plane/compass orientation on 
several points.

●     Check the Disable geometry detection button, when you need to create a point close to a geometric element yet 
without constraining it onto the existing geometry.

●     Check the Hide previsualisation curve to hide the previsualisation curve you are creating.
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Selecting 3D points

It is possible to select a scan of cloud either in the 
specification tree or directly in the geometry. 

The Select all points contextual menu is available within the 
3D curve action only, i.e. it is not available when you select 
the scan before entering the action but appears when the 3D 
Curve dialog box is open.

●     In the specification tree: 
❍     select the geometrical set just by clicking it, or

❍     right-click the geometrical set and choose Select all 
points in the geometrical set from the contextual 
menu, or

❍     select a point in the geometrical set, right-click it and 
choose Select all points in the geometrical set from the 
contextual menu.

●     In the geometry: select a point, right-click it and choose 
Select all points in the geometrical set from the contextual 
menu.

 

   
 

Contextual Options
 

 

Double-click your curve, right-click on the manipulator to 

display the contextual menu.

 

According to the creation type, the following options are available:

 Through Points Control Points Near points

Edit X X X

Keep this point X X X

Impose Tangency X  X 

Impose Curvature X  X

Set as Arc Limit   X

Remove this point X X X

Constrain this point X X X

Editing
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1.  Right-click any of the manipulators, and choose the 

Edit contextual menu to display the Tuner dialog box. 

This option allows you to redefine the tangency 

position, and its vector's step.

 

      
 

The Relative check box enables you to redefine the tangency 
relative position, and its vector's step.
The Reset Origin button allows you to reset the origin of the 
relative position.

Keeping a point

1.  Right-click an existing point and choose the Keep this 

point menu item to create a point at this location. 

A Point.xxx appears in the specification tree.

You can create a Point.xxx either on each control point 

or on the selected control points. 

Imposing a Tangency Constraint
Automatic Constraint
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●     When a curve is created in Through points or Near 
points mode, and its first point is constrained on any point 
of another curve, the new curve automatically is tangent to 
the curve on which its first point is constrained. As soon as 
the curve's second point is created, the imposed tangent is 
displayed on the new curve.
To deactivate the default option, uncheck the Impose 
Tangency contextual menu on the tangent vector. 

Tangency Constraint on Points

When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the 
point at which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the 
point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points: 

●     In Through points mode: tangency can be imposed on any point

●     In  Near points mode: tangency can be imposed independently on each end points only

●     In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as 
described in step 7 above. See also Constraining a Control Points Curve.

 Here is how to do it:

Open the 3DCurve1.CATPart document.

1.  Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose 

the Impose Tangency menu item.

Two sets of manipulators are displayed: 
●     two arrows representing the normed directions (vectors) of 

the tangency

●     circles representing manipulators for this vector

You can also modify the tangency constraint by: 
●     pulling the arrow

●     gliding the circles

●     double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then 
dragging the mouse.
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Right-clicking on any of the manipulators, you can also choose 
to define the constraint according to an external element: 

●     Use current plane orientation (P1)/Use compass 
normal (P2): the tangency constraint is defined in relation 
to the normal to the current plane, possibly defined by the 
normal to the compass main plane
When several points are constrained on the compass, all 
are modified if the compass settings are changed.
When this option is checked, the direction cannot be 
modified directly using the vector manipulator, but only 
using the compass.

●     Constrain on element: available only when a point is 
already constrained on a curve. The curve being 
created/modified becomes constraint in tangency or 
curvature to the constraining curve at this point.

❍     Tangency constraint: in this case you can only modify 
the vector's norm using the Edit contextual menu, and 
no longer the vector's direction, the latter being 
defined by the constraining curve.
Click the arrow to invert the tangency direction if 
needed.

❍     Curvature constraint: in this case you neither modify 
the vector's norm using the Edit contextual menu, nor 
the vector's direction, the latter being defined by the 
constraining curve.

By default, when the tangency vector is constrained onto another curve, its initial direction is retained.

●     Snap on elements: the vector's direction is defined by an 
external element. Grabbing a manipulators, you drag the 
pointer over a curve, and the curve becomes tangent to 
the curve detected by the pointer. 

If the pointer is over a point the direction is 
computed as the line going from the constrained 
point and the detected point.
If the pointer is over a plane, the tangency is 
defined by the normal to this plane.  
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●     When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected 
element and the vector's norm.

●     Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over 
geometric elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around 
to recover the curve preview indicating that you are ready to create a new point.
Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end 
points on another curve, as described in step 7 above. 

When setting a constraint on an end point, a text is displayed 
indicating the type of continuity between the two curves.

Right-click the text to display the contextual menu from which 

you can choose another continuity type: tangency, or 

curvature.

 

Note that: 
●     in Point continuity, only the selected point is constrained

●     in Tangent continuity, the selected point and the next one are constrained

●     in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining 
element, using the manipulators. However, you cannot constrain these points, because they are considered as already 
constrained. If you try to do so, a warning message is displayed. Nevertheless, you can add/remove points directly after the 
constrained end point, and the system resets the points as second and third points to be affected by the constraint, where 
applicable.

A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set 
constraint.

Imposing a Curvature Constraint
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Right-click an existing point and choose the Impose 

Curvature menu item. An arrow representing the curvature 

direction (vector) is displayed. Modifying the vector direction 

modifies the curvature direction.

The direction of the curvature is constrained in the plane 

defined as normal to the tangent vector.

 
●     To impose a curvature continuity, you must ensure that a 

tangency continuity already exists.

●     This option is only available for the Through points and 
Near Points creation type.

 

Setting as Arc Limit

Right-click an existing point and choose the Set As Arc Limit 

menu item to start/stop an arc limit on this point. The curve 

will pass through this point.

This option is only available for the Near points creation type.

  

You can use standard shortcuts (Ctrl and Shift keys) to select, multi-select, and de-select any combination of control points on 
these curves.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary 
analysis, auto detection (except for Snap on Control Point option), attenuation, and furtive display.
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Creating Paint Curves

This task shows you how to create and draw curves onto the polygon that entirely lie on it.

Open the Bunny1.CATPart document.

1.  Click the Paint Curve icon . 

 2.  Using the mouse, select the first point on the polygon.

To paint the curve, you can either click point by point (subsequently create new segments) or 
drag the mouse.

 3.  Double-click on the polygon to end the painting and exit the command.

 

 The curve (identified as Mesh Curve.xxx) is added to the specification tree.
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●     Hold the Ctrl button to complete the loop, and therefore exit the command.

 

●     You can now paint a curve using an existing curve that lies on the polymesh, either by:
❍     clicking a vertex to start or continue the paint curve, or

❍     snapping onto the curve and selecting a point on this curve.
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Generating Meshes

This task shows you how to generate a polygonal mesh from curves and selected triangles.

Open the Vase2.CATPart document.

1.  Click the Generate Mesh icon . 

The Generate Mesh dialog box displays.

 

 
2.  Using the Ctrl key, select the curves and triangles (if necessary).

3.  Define the tolerances:

●     Point Tolerance: tolerance for the fitting points

●     Curve Tolerance: tolerance for the fitting curves

●     Tessellation: resolution of the generated mesh
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4.  Click Apply to preview the polygonal mesh.

5.  Click OK to generate it.

6.  Perform the operation again with the other set of curves.

The generated mesh passes through the selected curves and vertices of the selected 

triangles.
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The mesh (identified as Mesh Generation.xxx) is added to the specification tree.

50Page Shape Sculptor Version 5 Release 13



Tessellating

This task shows how to tessellate a surface and convert it into a polygonal mesh.

Open the Tessellate1.CATPart document.

1.  Click the Tessellate icon .

The Tessellate dialog box displays.

 

 
2.  Select the surface(s) to be tessellated.

3.  Define the Tolerance parameter to control the tolerance to which the surface(s) can be 

tessellated.

4.  Click Apply.

 

 The tessellation feature (identified as Tessellation.xxx) is added to the specification 
tree.
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Editing
Decimating Meshes

Refining
Smoothing

Smoothing With a Brush
Deleting Triangles

Extracting Triangles
Copying Triangles

Slicing
Intersecting Meshes

Stitching
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Decimating Meshes
This task will show you how to decimate a mesh. 

Decimation is a command reducing the triangle count of a mesh for a quicker execution of commands. It also 
reduces the memory requirements for the model. Many large meshes can be represented accurately with less 
triangles.

Decimation can be performed on the entire region or a selected region of the mesh.

 
Open the SmoothMesh01.CATPart from the samples directory

 

 

1.  Click the Decimation icon  and select a mesh. The dialog box is displayed:

 

2.  Check the type of decimation you want to apply:

●     by Chordal Deviation if you want to preserve the shape of your model, even in areas with a 

high curvature,

●     by Edge Length if you want to remove triangles with tiny edges and obtain a more uniform 

mesh. However this may result in a loss of accuracy in areas with a high curvature.

 
3.  Then, decide how you want the decimation to process:

Check Minimum if you want to apply a Minimum criterion:

●     For a decimation by Chordal Deviation, it is the chordal deviation that should not be exceeded 

during decimation. Decimation stops when the chordal deviation limit has been reached.

●     For a decimation by Edge Length, it is the minimal length the edges of triangles should have. 

The decimation stops when all triangle edges are longer than the value set. However, it may be 

impossible to collapse some edges that will remain below this value. 
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Check Target Percentage if you want to obtain a given final number or percentage of triangles. 

Enter either the percentage value or the Target Triangle Count. Those fields are linked to each 

other and updated simultaneously.

Current Triangle Count indicates the current number of triangles, either of the original model when 

you enter the action, or of the result model when you have clicked Apply.
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4.  You may need to control the decimation of free edges, when a rectangular shape sees its corners cut off 

after decimation. You can avoid this by checking Free Edge Deviation. This activates the maximum 

allowable deviation that can occur for vertices on the boundary. The resulting decimated boundary will 

not be at a distance greater than this parameter from the original boundary. 
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Refining
This task shows how to refine a polygonal mesh.

Refinement is a command increasing the details of a polygonal mesh by splitting its triangles. It can be performed on the entire 
mesh or a selected region of the mesh. 

Refinement preserves the selection: each selected triangle will be removed from the mesh and replaced with two triangles. The 
two new triangles lie in the same plane as the original triangle. Additional triangles besides those selected may be refined and 
these will not be placed in the selection after refinement.

Open the Refine1.CATPart document.

1.  Click the Refine icon . 

The Refine dialog box displays.

 

 
2.  Select the polygonal mesh.

 
You can use the Wireframe mode from the View toolbar to display the number of triangles.

 
3.  Click Apply to preview the refinement.

4.  Click OK to exit the command.

 

Before refinement After refinement 

●     You can click Apply in the dialog box as many times as desired to perform a more precise refinement.

●     You can perform several selections of triangles while in the command.
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Smoothing

This task shows how to smooth the vertices of a polygonal mesh.

Smoothing can be performed on the entire mesh or a selected region of the mesh.

Open the Bunny1.CATPart document.

1.  Click the Smooth icon . 

The Smooth dialog box displays.

 

 
2.  Select the polygon.

3.  Define the number of Steps of the smoothing between 1 and 100.

4.  Define the Pressure value between 0 and 100.

A value of 0 means there is no smoothing, and a value of 100 corresponds to the maximum smoothing. 

5.  Click Apply to preview the smoothing.

The Maximum deviation is displayed.

6.  Click OK.
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 The example above shows a smoothing using the 
following values:

Steps = 1
Pressure = 10

The example above shows a smoothing using the 
following values:

Steps = 1
Pressure = 90

 

 The example above shows a smoothing using the 
following values:

Steps = 40
Pressure = 10

The example above shows a smoothing using the 
following values:

Steps = 40
Pressure = 90

●     The Preserve Volume option enables to keep the volume of the polygonal mesh after the smoothing (as 

you can see in the fourth example, the volume was not kept).

●     The Smooth Boundaries option enables to smooth the boundaries (free edges) of the polygonal mesh.

●     The Tolerance value enables to check if any of the vertices moved by a distance greater than the user 
specified tolerance. If the tolerance is violated, the vertices are restored to their original position and the 
smoothing is not performed. If successful, the Maximum Deviation of the vertices is displayed.
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Smoothing With a Brush

This task shows how to locally smooth the polygonal mesh using a brush.

Open the Bunny1.CATPart document.

1.  Click the Brush Smooth icon .

The Brush Smooth dialog box displays.

 

 
2.  Define the Radius value corresponding to the size of the brush.

3.  Define the Pressure value between 0 and 100.

A value of 0 means there is no smoothing, and a value of 100 corresponds to the 

maximum smoothing. 
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4.  Choose the smoothing type:

❍     Flatten: the mesh tends to become flatter as it is being smoothed.

❍     Round: the mesh is smoothed while keeping the rounded shapes.

 5.  Click Apply to preview the smoothing.

6.  Click OK.
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 Flatten Round
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Deleting Triangles

This task shows how to delete selected triangles of a polygonal mesh.

Open the Pin1.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

 

 
2.  Click the Delete triangles icon . 

The selected triangles are deleted from the polygonal mesh.
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Extracting Triangles

This task shows how to create a mesh by extracting a selection of triangles from a polygonal 
mesh.

Open the Pin3.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

 

 2.  Click the Extract triangles icon . 

 

 

A mesh is created with the selected triangles: they are extracted and deleted from 

the original mesh and added to a new polygonal mesh.

This new mesh (identified as Polymesh.xxx) is added to the specification tree. 
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Copying Triangles

This task shows how to create a mesh by copying triangles from of a polygonal mesh.

Open the Pin3.CATPart document.

1.  Select the triangles to delete using one of the selection components.

In our example, we chose the Curve Select component.

 

 
2.  Click the Copy triangles icon . 

 

 A mesh is created with the selected triangles: they are copied from the original mesh 
and added to a new polygonal mesh.
This new mesh (identified as Polymesh.xxx) is added to the specification tree. 
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Slicing

This task shows how to slice a polygonal mesh using curves and scans.

Open the Pin3.CATPart document.

1.  Click the Slice icon .

The Slice dialog box displays.

 

 
2.  Select a polygonal mesh.

3.  Select one or more curves or scans.

●     The curves do not need to lie on the mesh: if they do not lie, they will be projected onto 
the mesh using a normal projection, before the slicing operation.

 

 
4.  Click Apply.

All boundaries (free edges) are highlighted.

5.  Click OK.
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 A hole is created in the polygonal mesh.

A refinement will be performed on the mesh in the area of the slicing entity (curve or scan).
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Intersecting Meshes

This task shows how to slice two polygonal meshes along their intersection.

Open the Intersect1.CATPart document.

1.  Click the Mesh Intersect icon .

The Mesh Intersect dialog box displays.

 

 
2.  Select the first mesh.

3.  Press the Ctrl key and select the second mesh.

Their intersection is highlighted in blue.
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4.  Select intersection type:

●     Slice: meshes are sliced

●     Create Curve: meshes are not sliced, however curves are created at each intersection. These curves 

appear in the specification tree as Intersection Curve.xxx.

 5.  Click Apply to preview the intersections.

 

 Slice Create Curve

 6.  Click OK to exit the command.
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Stitching

This task shows how to stitch two or more polygonal meshes into one mesh, along their free 
boundaries.

Open the Felix2.CATPart document.

1.  Slice the two polygonal meshes as shown in the previous task.

2.  Click the Stitch icon .

The Stitching dialog box displays.

 

 

3.  Select a hole along the boundary of the first mesh.

The blue arrow shows you which boundary is selected.
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4.  Holding the Ctrl key, select a hole along the boundary of the second mesh.

The blue arrow shows you which boundary is selected.
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5.  Adjust the tolerance using the spinners (in our scenario, it is set to 2.5 mm).

If a too low value is set, holes still remain.

 
6.  Click Apply to preview the stitching.

Meshes are merged and stitched into one mesh.

Here the mesh is displayed as flat. Refer to Display Options and Graphic Properties 

for further information.
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7.  Click OK to exit the command.

The element (identified as Stitching.xxx) is added to the specification tree.

Stitching cannot create non-manifold edges.
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Modeling
Editing Curves Using Control Points

Projecting Curves
Sculpting Curves

Embossing
Pushing / Pulling a Mesh

Sculpting Surfaces
Modeling Using a Box
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Editing Curves Using Control Points

This task explains how to modify a curve using its control points.

Open the EditControlPoints1.CATPart document.

1.  Select the curve you wish to 

edit.

2.  Click the Control Points icon 

.

Control points and lines are 
displayed, along with the 3D 
compass and the curve degree.

By default all control points and mesh lines are selected. Click a specific point to deform the 
surface at this point only, or select a set of points using the Ctrl-key or Shift-key while clicking 
(multi-selection capabilities). The same applies to mesh lines.

3.  Move the pointer over a point 

or a line.

Arrows are displayed 
according to the Support 
and Law options active in 
the Control Points dialog 
box.
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●     Support defines the type of 
translation to be applied

●     Law defines the type of 
deformation that is to be applied 
when several control points have 
been selected.

4.  Pull on the arrow matching 

the direction in which you 

want to deform the curve.

 

5.  Use the Dashboard to display 

the order number directly on 

the curve, using the U, V 

Orders  icon.

The value is displayed on 
the curve.

6.  Use the contextual menu to 

choose the order number for 

the curve.
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If you increase the order 
number to 11, the result 
is: 

 

7.  Click OK in the Control Points dialog box to validate the modifications.

●     Use the Control Points dialog box to modify the curve according to certain predefined laws.

●     To perform a quick analysis of the mesh line inflection, choose the Inflections checkbox.
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●     Further modification options are available from the More... button of the Control Points 
dialog box: 

❍     Freezing of the selected points (no other can be selected) and of the Support option

❍     Dynamic display of the initial curve and of the delta as you pull on the control points.

❍     Global selection/de-selection of control points using the Select All  and De-

Select All  icons, without having to click the geometry.
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Projecting Curves

This task shows you how to project curves on surfaces.

Open the Project1.CATPart document.

1.  Press the Ctrl key and select the curves you want to project.

 
2.  Click the Project Curve icon . 

The Project Curve dialog box displays.

 

 
3.  Choose the projection orientation from the Projection dialog box: 

●     View: projection according to the current view

●     Compass: projection according to the compass

●     Normal: projection normal to the surface

4.  Press the Ctrl key and select the surface or set of surfaces on which the curve(s) should be projected. 

5.  Click Apply to preview the projected curves on the target surface.
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Projection according to
the current view

Projection according to
the compass orientation 

Projection according to
the normal to the surface

6.  Click OK to create the projected curves.

Curves (identified as Curve.xxx) are added to the specification tree.
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Sculpting Curves

This task shows you how to sculpt a polygonal mesh a curve or a set of connected curves.

Open the Pin4.CATPart document.

1.  Click the Curve Sculpt icon . 

The Curve Sculpt dialog box displays.

 

 
2.  Holding the Ctrl key, select the curves to sculpt with.

3.  Select the polygonal mesh.

4.  Click Apply.
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5.  Define the profile:

●     Smooth

●     Sharp (used in our example)

●     Circular

You can check the Dynamic button to automatically sculpt the mesh on the fly.

 
6.  Define the influence area around the curves:

●     Check the Show button to display the area that is affected by sculpting on the polygonal 

mesh. Use the manipulators to define the area (as shown in the picture)

●     Click Refine to refine the sculpt by adding triangles

●     Check the Uniform button and use the spinners if you wish to force a constant transition 

width along the curves.
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If you uncheck the Uniform button, you are able to define the influence area curve 
by curve.
Simply position the manipulator on the curve whose area you wish to  modify and 
drag the manipulator to the desired transition width.
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7.  Define the offset:

●     Check the Show button to display the change to the sculpting curve before 

applying it to the polygonal mesh. Use the manipulators to define the offset (as 

shown in the picture)

●     Check the Uniform button and use the spinners if you wish to force a constant 

offset.

 

If you uncheck the Uniform button, you are able to define the offset curve by curve.
Simply position the manipulator on the curve you wish to modify the offset and drag 
the manipulator to the desired offset.
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8.  Click OK to end the sculpt.

Here is the result:

84Page Shape Sculptor Version 5 Release 13



Embossing

This task shows how to emboss a polygonal mesh using curves.

Open the Pin4.CATPart document.

1.  Click the Emboss icon . 

The Emboss dialog box displays.

 

 
2.  Holding the Ctrl key, select the curves to be used in embossing.

3.  Select the mesh to emboss (you can select inside or outside the curves, in our example 

we selected outside)

4.  Click Apply.
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5.  Define the profile:

●     Smooth (used in our example)

●     Sharp

You can check the Dynamic button to automatically sculpt the mesh on the fly.

 
6.  Define the influence area around the curves:

●     Check the Show button to display the area that is affected by embossing on the 

polygonal mesh. Use the manipulators to define the area (as shown in the 

picture)

●     Click Refine to refine the embossed area by adding triangles, therefore 

increasing the mesh resolution.

●     Use the spinners to force a constant transition width along the curves.
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7.  Define the offset:

●     Check the Show button to display the change to the curves to be embossed 

before applying it to the polygonal mesh. Use the magenta arrow to define the 

offset (as shown in the picture)

●     Use the spinners to force a constant offset.

 

 

You can change the offset direction, using:

●     either the spinners or the cyan arrow to define a value for X, Y, and Z.
Here is an example with X= -50, Y=0, and Z=100.
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●     the compass: Adjust the compass to the desired direction by moving the 
compass on the selected mesh, then right-click the offset arrow and select Align 
to compass contextual menu.
The offset direction is now aligned with the compass direction.

 
Make sure the Show button is checked.

 

 8.  Click OK to exit the command.

   
 

Selecting multi-loops
 It allows you to emboss a more complex shape on the mesh.
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Open the EmbossMultiCurves1.CATPart document.

1.  Click the Emboss icon . 

The Emboss dialog box displays.

2.  Holding the Ctrl key, successively select the sketches of the outer loop and the inner 

loop.

3.  Select the mesh to emboss outside the inner loop and inside the outer loop.

4.  Set the Offset as 10mm.

5.  Click Apply.
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Pushing / Pulling a Mesh

This task shows how to locally modify a polygonal mesh by pushing or pulling a point on the mesh.

Open the PushPull1.CATPart document.

1.  Click the Push/Pull icon .

The Push Pull dialog box displays.

 

 
2.  Define the profile of the sculpted area:

❍     Smooth

❍     Sharp 

❍     Circular

 
The sculpted area can be defined by:

 
●     a point

 
1.  Select a point on the mesh.

2.  Define the influence area around the point:

●     Check the Radius button to define a constant influence area (that is the circle around the center point) and 

display the magenta arrow in the geometry.

●     Use the spinners to define the push/pull magnitude.

●     Use the arrow to define the push/pull direction.
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 3.  Click Apply to preview the push/pull.

The Radius button is greyed out.

 

 
●     one or more curves forming a closed loop

●     one or more curves and a part of the mesh boundary

●     the mesh boundary

 
Make sure the Radius button is unchecked.

 
1.  Select the curve(s) or mesh boundary (hold the Ctrl key if you selected several curves).

In our scenario, we selected three curves.

2.  Click a point inside the curve(s) or boudary.

3.  Click Apply.

 
3.  Define the offset:

●     Check the Show button to display the cyan arrow in the geometry. 

●     Use either the spinners or the arrow to define the offset.
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Point selection Three-curve selection

You can click Refine to refine the sculpt by adding triangles, therefore increasing the mesh resolution.

  
 

 Point selection with Smooth profile Point selection with Circular profile
 

Three-curve selection with Sharp profile Three-curve selection with Circular profile
 

 One curve & mesh boundary selection with Smooth profile One curve & mesh boundary selection with Sharp profile
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 Mesh boundary selection with Smooth profile Mesh boundary selection with Sharp profile
 

4.  Click OK to exit the command.
 

You can define the offset direction using:

 

●     either the spinners or the cyan arrow to define a value for 

X, Y, and Z.

Here is an example with X= 10, Y=3, and Z=25.

●     the compass: Adjust the compass to the desired direction 

by moving the compass on the selected mesh, then right-

click the offset arrow and select Align to compass 

contextual menu.

The offset direction is now aligned with the compass 

direction.
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Sculpting With Surfaces

This task shows how to modify a portion of a polygonal mesh with a NURBS surface.

Open the SurfaceSculpt1.CATPart document.

1.  Click the Surface Sculpt icon . 

 
2.  Press the Ctrl key and select four curves that form the closed contour of the region to 

be sculpted.

 

 
3.  Click on the polygonal mesh inside the curves. 
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Control points are displayed as well as the Control Points dialog box.

4.  Sculpt the polygonal mesh using the Control Points tool. 

For further information, please refer to the Editing Surfaces Using Control Points chapter in the 
FreeStyle Shaper, Optimizer, & Profiler documentation.

 

 
5.  Click OK in the Control Points dialog box.
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Modeling Using a Box

This task show to apply global deformation to one mesh using a box.

Open the Felix1.CATPart document.

1.  Click the Box Modeling icon . 

The Box Modeling dialog box displays.

 

 
2.  Select the mesh to be deformed.

A box frames the mesh.

You can also select the mesh before entering the command.
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 Dots are displayed in the middle of each face of the box.

 
3.  Move the mouse close to any of the dots: two arrows display letting to stretch the 

model in any direction.

 

 
4.  Click OK when you are satisfied with the modeling.
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Analyzing
Display Options and Graphic Properties

Analyzing Using Highlights
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Display Options and Graphic Properties

This  task shows how to change the display option of clouds of points.

Open the Visu1.CATPart model the from the samples directory. It consists of four clouds of 
points: 

●     a mesh,

●     a cloud of points,

●     a set of scans,

●     a set of grids.

Their default colors are respectively: 
●     orange,

●     green,

●     cyan,

●     cyan.

The display options are available from the Cloud Display Options box. Further graphic 
properties are available from the Edit/Properties menu, in the Graphic tab. 

From the Cloud Display Options box, you can:

●     Choose the sampling of clouds of points (N of 100 points are displayed). 

●     Choose to display scans or grids as polylines, points, or both. 

●     Choose to display triangles, free edges, non-manifold edges of meshes. You can also choose 
their display mode: flat or smooth. 

From the Edit/Properties menu, you can:

●     Choose the fill color of the mesh and its transparency level,

●     Choose the color and symbol of the points of a cloud,

●     Choose the color, type and thickness of scans and grids,

●     Choose to elements pickable or not.

Cloud Display Options box 

The images below are only examples.

1.  Click the Cloud Display  icon  at the bottom of the screen. The Cloud Display 

Option dialog box is displayed.
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2.  Select the cloud to modify. Display options are proposed according to the type of the 

cloud selected:

 

Following options are not yet available: 

●     Protected,

●     Orientation,

●     Shrink,

●     Normal.

3.  For the cloud of points, you can choose to display only a percentage of the points making 

the cloud, using the Sampling option. By default, 100% of the points are displayed. You 

can change this value with the associated spinner.

101Page Shape Sculptor Version 5 Release 13



Sampling=100 Sampling=25

The Symbol options are not available in that box, but in the Graphic Properties menu.

For the sets of scans or grids, you can display them as line of points or points or both: 

For the mesh, you can: 
●     display the triangles, 
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●     visualize only the vertices for a lighter display (do not forget to de-activate the Smooth, Flat 
or Triangles options)

 instead of 

 

 
●     the free edges in yellow, 

●     the non-manifold facets and their vertices in bold white lines. 
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●     If you choose the display of triangles, the triangles accepting a non-manifold edge have their 
edges displayed as regular white lines. 
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●     display the  mesh as a smooth or a flat mesh.

 or 

 

The free edges displayed are those of the complete cloud of points: 
●     if you activate only a portion of a cloud of points, the free edges of that portion are not 

displayed.
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●     if you remove a portion of a cloud of points, the free edges of the remaining portion are 
displayed.

●     If you move a cloud of points or a mesh, its graphic display options (not the graphic 
properties) are lost.

●     The display options are not saved in the CATPart while the graphic properties are.

Edit/Properties menu (Graphic tab) 

For more information about this menu, please refer to the Displaying and Editing Graphic 
Properties  chapter in the CATIA Infrastructure user's guide.

The images below are only examples.
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You can access this menu through Edit/Properties, or through the pop-up menu of the element, 
or display the Graphic Properties toolbar (View/Toolbars/Graphic Properties). 

 

or
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●     The color displayed in the Graphic Properties toolbar applies to meshes only.

●     The graphic properties are saved in the CATPart.

●     Use Fill/Color and Transparency to modify the color and transparency of meshs:

 

 

Please note that : 
●     the color of mesh free edges is yellow, and is not editable,

●     the color of non-manifold edges is white, and is not editable,

●     the default color of scans has changed to cyan.

For a higher transparency quality, go to Tools/Options/Display/Performances and check the 
High (Alpha blending) option.
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●     Use Edges/Color, Line type and Thickness to modify the display of scans and grids or of 
the triangles of a mesh :

●     Use Points/Color and Symbol to modify the display of clouds of points:

 

●     Use the Pickable check box to make an element pickable or not, and choose the pick option 
in the list below.
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Analyzing Using Highlights
This task shows how to perform an analysis of the surfaces quality of shaded highlights.
It analyses the angle between surface normals and a predefined direction. Dependent on the angle, it sets the color at this surface 
position. All positions with the same angle between surface normal and predefined direction get the same shading color. If the angle is 
90 degrees, the resulting stripe is the silhouette line related to the predefined direction.

Open the Highlights1.CATPart document.

Make sure the Shading and Material visualization options are active by selecting the Customize View icon   in  the View mode 

toolbar. 

1.  Click the Highlight icon .

The Highlights dialog box displays.

You do not need to select the part in the specification tree as the analysis works globally on the part.

2.  Define the display options:

●     Grid: two predefined directions define a grid of stripes (not necessarily perpendicular) on the surface. The plane tool u and v 

direction, are used as predefined directions in grid mode. If you uncheck the Grid options, it switches to the Stripes mode: the 

plane tool normal is the predefined direction.

●     Global: the whole part is highlighted.

●     Angle: highlights are distributed per angle.

●     Density: defines the number of stripes or grid lines.

●     Thickness: defines the thickness of stripes or grid lines. 

●     Sharpness: defines the sharpness of stripes or grid lines (soft or hard color transition). 

Here is an example the following values
Grid and Global

Density=50
Thickness=0.30
Sharpness=0.80

Here is an example the following values
Grid and Global

Density=80
Thickness=0.70
Sharpness=0.30
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Here is an example the following values
Grid, Global, and Angle

Density=80
Thickness=0.70
Sharpness=0.30

Here is an example the following values
Global and Angle

Density=80
Thickness=0.70
Sharpness=0.30

3.  Right-click the plane tool to display the Highlights 

Properties.

●     Define the snap mode to snap tool position and optionally 

orientation on geometry

❍     Off: no snap mode

❍     Vertex: the plane tool snaps on a vertex. Dependent on the 

vertex (surface corner, 3D curve endpoint), the direction is 

adapted to the surface normal or curve tangent 

❍     Curve: the plane tool snaps on a curve or surface edge. As a 

result in stripes mode the silhouette line of the plane tool 

normal crosses the edge at the plane tool origin

❍     Surface: the plane tool snaps on a surface and adapts the 

surface normal. As a result in grid mode the silhouette line 

of the plane tool u direction and the silhouette line of the 

plane tool v direction are crossing at the plane tool origin 

●     Define the rotation mode of the 3D tool: 

❍     Dynamic: normal dynamic rotation mode

❍     Discrete: the rotation of the tool snaps to certain relative 

grid angles.

❍     Grid: the rotation of the tool snaps to certain absolute grid 

angles.

❍     Static: the rotation is activated by a mouse click on the 

corresponding rotation handle of the tool. The grid value 

defines the specific rotation angle

●     Define the rotation value by entering a value or using the 

spinners
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●     Define the numerical feedback of the 3D tool: 

❍     Distance 3D: direct distance between the start position of 

the translation and the current position

❍     Distance XYZ: distance shown in x, y and z components of 

the current coordinate system

❍     Coordinates: absolute position of the tool in the model 

coordinate system

 
 

4.  Click OK to create the analysis.

For further information, please refer to the CATIA Automotive Class A documentation.
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Interoperability with Wireframe
Creating Points
Creating Lines
Creating Planes
Creating Circles
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Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle center

●     tangent point on a curve

●     between

 
Open the Points3D-1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

Coordinates 
●     Enter the X, Y, Z coordinates 

in the current axis-system.

●     Optionally, select a reference 
point.

The corresponding 
point is displayed.

 

 

When creating a point within a user-defined axis-system, note that the Coordinates in 
absolute axis-system check button is added to the dialog box, allowing you to be define, or 
simply find out, the point's coordinates within the document's default axis-system.
If you create a point using the coordinates method and an axis system is already defined and 
set as current, the point's coordinates are defined according to current the axis system. As a 
consequence, the point's coordinates are not displayed in the specification tree.

The axis system must be different 
from the absolute axis.  
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On curve 
●     Select a curve

●     Optionally, select a reference 
point.

If this point is not on 
the curve, it is 
projected onto the 
curve.
If no point is selected, 
the curve's extremity is 
used as reference.

 

●     Select an option point to 
determine whether the new 
point is to be created: 

❍     at a given distance along 
the curve from the 
reference point

❍     a given ratio between the 
reference point and the 
curve's extremity.

      
●     Enter the distance or ratio 

value.
If a distance is specified, it 
can be: 

❍     a geodesic distance: the 
distance is measured 
along the curve

❍     an Euclidean distance: the 
distance is measured in 
relation to the reference 
point (absolute value).

The corresponding point is 
displayed.
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If the reference point is located at the curve's extremity, even if a ratio value is defined, the 
created point is always located at the end point of the curve.

You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the 

curve.

●     click the Middle Point button to display the mid-point of the curve.

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is 
not closed) when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, 
using the currently created point as the reference, as described in Creating Multiple Points 
in the Wireframe and Surface User's Guide. 

You will also be able to 
create planes normal to 
the curve at these 
points, by checking the 
Create normal planes 
also button, and to 
create all instances in a 
new geometrical set  by 
checking the Create in 
a new geometrical 
set button.
If the button is not 
checked the instances 
are created in the 
current geometrical set 
.

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference 
point is the projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be 
used as a reference point, or it creates an extremum point, and highlights it (you can then 
select another one if you wish) or the system prompts you to manually select a reference 
point.

 

Extremum points created on a 
closed curve are now aggregated 
under their parent command and 
put in no show in the specification 
tree.
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On plane 
●     Select a plane.

●     Optionally, select a point to 
define a reference for 
computing coordinates in the 
plane.

If no point is selected, 
the projection of the 
model's origin on the 
plane is taken as 
reference. 

 

 
 

●     Optionally, select a surface on 
which the point is projected 
normally to the plane.

If no surface is 
selected, the behavior 
is the same.

Furthermore, the 
reference direction (H 
and V vectors) is 
computed as follows: 
With N the normal to 
the selected plane 
(reference plane), H 
results from the 
vectorial product of Z 
and N (H = Z^N). 
If the norm of H is 
strictly positive then V 
results from the 
vectorial product of N 
and H (V = N^H).
Otherwise, V = N^X 
and H = V^N.

Would the plane move, 
during an update for 
example, the reference 
direction would then be 
projected on the plane. 

●     Click in the plane to display a point.
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On surface 
●     Select the surface where the 

point is to be created.

 

●     Optionally, select a reference 
point. By default, the surface's 
middle point is taken as 
reference. 

●     You can select an element to 
take its orientation as 
reference direction or a plane 
to take its normal as reference 
direction.
You can also use the 
contextual menu to specify 
the X, Y, Z components of the 
reference direction.

●     Enter a distance along the 
reference direction to display 
a point.

 
      

Circle center 
●     Select a circle, circular arc, or 

ellipse.

A point is displayed at 
the center of the 
selected element. 
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Tangent on curve 
●     Select a planar curve and a 

direction line.

A point is displayed at 
each tangent. 

      
The Multi-Result 
Management dialog box 
is displayed because 
several points are 
generated. 

●     Click YES: you can then select 
a reference element, to which 
only the closest point is 
created.

●     Click NO: all the points are 
created.

Between
●     Select any two points.

●     Enter the ratio, that is the 
percentage of the distance 
from the first selected point, 
at which the new point is to 
be.
You can also click Middle 
Point button to create a point 
at the exact midpoint (ratio = 
0.5).

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is 
not closed) when using the Middle Point option.

119Page Shape Sculptor Version 5 Release 13



●     Use the Reverse direction 
button to measure the ratio 
from the second selected 
point.

 
If the ratio value is greater than 1, the point is located on the virtual line beyond the selected 
points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.
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Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 It also shows you how to automatically reselect the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box appears.

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element 
selection.

Point - Point 

 
This command is only available with the 
Generative Shape Design 2 product.

●     Select two points.
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A line is displayed between the 
two points.
Proposed Start and End points 
of the new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, 
i.e. going from one point to the other 
according to the shortest distance 
along the surface geometry (blue line 
in the illustration below).
If no surface is selected, the line is 
created between the two points based 
on the shortest distance.

If you select two points on closed surface 
(a cylinder for example), the result may 
be unstable. Therefore, it is advised to 
split the surface and only keep the part on 
which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.
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●     Specify the Start and End points of the new line, that is the line endpoint location in 

relation to the points initially selected. These Start and End points are necessarily beyond 
the selected points, meaning the line cannot be shorter than the distance between the initial 
points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected 
Start and End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

Point - Direction 
 

●     Select a reference Point and a 
Direction line.
A vector parallel to the direction line is 
displayed at the reference point. 
Proposed Start and End points of the 
new line are shown.
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●     Specify the Start and End points of 
the new line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

  

Angle or Normal to 
curve
 

●     Select a reference Curve and a 
Support surface containing that 
curve.
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- If the selected curve is planar, 
then the Support is set to 
Default (Plane).

- If an explicit Support has 
been defined, a contextual 
menu is available to clear the 
selection.

 
●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given 
angle with respect to the 
tangent to the reference curve 
at the selected point. These 
elements are displayed in the 
plane tangent to the surface at 
the selected point. 
You can click on the Normal to 
Curve button to specify an 
angle of 90 degrees. 
Proposed Start and End points 
of the line are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.
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●     Click the Repeat object after OK if 
you wish to create more lines with the 
same definition as the currently 
created line. 
In this case, the Object Repetition 
dialog box is displayed, and you key in 
the number of instances to be created 
before pressing OK.

As many lines as indicated in the dialog 
box are created, each separated from the 
initial line by a multiple of the angle 
value.

 

You can select the Geometry on Support check box if you want to create a geodesic line onto 

a support surface. 

The figure below illustrates this case.

 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how 
to display these parameters in the 3D geometry.
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Tangent to curve
 

●     Select a reference Curve and a point 
or another Curve to define the 
tangency. 

❍     if a point is selected (mono-
tangent mode): a vector tangent 
to the curve is displayed at 
the selected point.

❍     If a second curve is selected (or a 
point in bi-tangent mode), you 
need to select a support plane. 
The line will be tangent to both 
curves.

 - If the selected curve is a line, 
then the Support is set to 
Default (Plane).

- If an explicit Support has 
been defined, a contextual 
menu is available to clear the 
selection.

 When several solutions are 
possible, you can choose one 
(displayed in red) directly in the 
geometry, or using the Next 
Solution button.

     

 

 

Line tangent to curve at a given point Line tangent to two curves
●     Specify Start and End points to define the new line.

The corresponding line is displayed.
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Normal to surface 
 

●     Select a reference Surface and a 
Point.
A vector normal to the surface is 
displayed at the reference point. 
Proposed Start and End points of the 
new line are shown.

●     Specify Start and End points to define 
the new line.
The corresponding line is displayed.
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Bisecting 
 

●     Select two lines. Their bisecting line is 
the line splitting in two equals parts 
the angle between these two lines. 

●     Select a point as the starting point for 
the line. By default it is the 
intersection of the bisecting line and 
the first selected line.
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●     Select the support surface onto which 
the bisecting line is to be projected, if 
needed.

●     Specify the line's length in relation to 
its starting point (Start and End 
values for each side of the line in 
relation to the default end points).
The corresponding bisecting line, is 
displayed.

●     You can choose between two 
solutions, using the Next Solution 
button, or directly clicking the 
numbered arrows in the geometry.

3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

  
●     Regardless of the line type, Start and End values are specified by entering distance values 

or by using the graphic manipulators.

●     Start and End values should not be the same.

  
 

●     Select the Length Type: 
❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be greyed out when one of the Infinite options is 
chosen.

     
●     Check the Mirrored extent option to create a line symmetrically in relation to the selected 

Start point.

●     In most cases, you can select a support on which the line is to be created. In this case, the 
selected point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting 
the Reverse Direction button (not available with the point-point line type).
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This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 
The Reselect Second Point at 
next start option appears in 
the Line dialog box.

3.  Check it to be able to 

later reuse the second 

point.

4.  Create the second point.

5.  Click OK to create the 

first line.

  
 The Line dialog box opens again 

with the first point initialized 
with the second point of the 
first line.

6.  Click OK to create the second 

point.

7.  Click OK to create the second line, 

and so on.

 

 To stop the repeat action, simply uncheck the option or click Cancel in the Line dialog box. 

Automatic Reselection
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Creating Planes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a 
line

●     through a planar 
curve

●     normal to a 
curve

●     tangent to a 
surface

●     from its equation

●     mean through 
points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can 
move using the graphic manipulator.

Offset from plane

●     Select a reference Plane then 
enter an Offset value.

A plane is displayed offset from the 
reference plane.
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Use the Reverse Direction button to  
reverse the change the offset 
direction, or simply click on the arrow 
in the geometry.

      
●     Click the Repeat object after OK if you 

wish to create more offset planes . 
In this case, the Object Repetition dialog 
box is displayed, and you key in the number 
of instances to be created before pressing 
OK.

As many planes as indicated in the 
dialog box are created (including the 
one you were currently creating), each 
separated from the initial plane by a 
multiple of the Offset value. 

 

Parallel through point 

●     Select a reference Plane and a 
Point.
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A plane is displayed parallel to the 
reference plane and passing through 
the selected point.

Angle or normal to plane 

●     Select a reference Plane and a 
Rotation axis.
This axis can be any line or an 
implicit element, such as a 
cylinder axis for example. To 
select the latter press and hold the 
Shift key while moving the pointer 
over the element, then click it.

●     Enter an Angle value.
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A plane is displayed passing through 
the rotation axis. It is oriented at the 
specified angle to the reference plane. 

●     Click the Repeat object after OK if you wish to create more planes at an angle from the 
initial plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.

As many planes as indicated in the 
dialog box are created (including the 
one you were currently creating), each 
separated from the initial plane by a 
multiple of the Angle value.

Here we created five planes at an 
angle of 20 degrees.

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out 
how to display these parameters in the 3D geometry.

Through three points 

●     Select three points.
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The plane passing through the three 
points is displayed. You can move it 
simply by dragging it to the desired 
location.

Through two lines 

●     Select two lines.

The plane passing through the two 
line directions is displayed.
When these two lines are not 
coplanar, the vector of the second line 
is moved to the first line location to 
define the plane's second direction. 
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Check the Forbid non coplanar lines button to specify that both lines be in the same plane.

Through point and line 

●     Select a Point and a Line.

The plane passing through the point 
and the line is displayed. 
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Through planar curve 

●     Select a planar Curve.

The plane containing the curve is 
displayed.

Tangent to surface 

●     Select a reference Surface and a 
Point.
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A plane is displayed tangent to the 
surface at the specified point.

Normal to curve 

●     Select a reference Curve.

●     You can select a Point. By default, 
the curve's middle point is selecte.
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A plane is displayed normal to the 
curve at the specified point. 

Mean through points 

●     Select three or more points to 
display the mean plane through 
these points.

It is possible to edit the plane by first 
selecting a point in the dialog box list 
then choosing an option to either:

●     Remove the selected point

●     Replace the selected point by 
another point.
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Equation 

●     Enter the A, B, C, D components 
of the Ax + By + Cz = D plane 
equation.

 

Select a point to position the plane 
through this point, you are able to 
modify A, B, and C components, the 
D component becomes grayed.

 

Use the Normal to compass button 
to position the plane perpendicular to 
the compass direction.

Use the Parallel to screen button to 
parallel to the screen current view.
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3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
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Creating Circles

 

This task shows the various methods for creating circles and circular arcs: 

●     center and radius

●     center and point

●     two points and radius

●     three points

●     bitangent and radius

●     bitangent and point

●     tritangent

●     center and tangent

 

Open the Circles1.CATPart document.
Please note that you need to put the desired geometrical set in show to be able to perform the corresponding scenario. 

 
1.  Click the Circle icon .

The Circle Definition dialog box appears. 

2.  Use the combo to choose the desired circle type.

Center and radius 
 

●     Select a point as circle Center.

●     Select the Support plane or surface where the circle 
is to be created.

●     Enter a Radius value.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 
If a support surface is selected, the circle lies on the plane tangent to the surface at the selected point.

Start and End angles can be specified by entering values or by using the graphic manipulators.
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Center and point 
 

●     Select a point as Circle center.

●     Select a Point where the circle is to be created.

●     Select the Support plane or surface where the circle 
is to be created.

The circle, which center is the first selected point and 
passing through the second point or the projection of 
this second point on the plane tangent to the surface at 
the first point, is previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

      

Two points and radius 
 

●     Select two points on a surface or in the same plane.

●     Select the Support plane or surface.

●     Enter a Radius value.

The circle, passing through the first selected point and 
the second point or the projection of this second point 
on the plane tangent to the surface at the first point, is 
previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two selected points as end 
points. 

You can use the Second Solution button, to display 
the alternative arc.
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You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

     

Three points 
 

●     Select three points where the circle is to be created.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two of the selected points 
as end points.

 

You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.
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Bi-tangent and radius 
 

●     Select two Elements (point or curve) to which the 
circle is to be tangent.

●     Select a Support surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 
●     Enter a Radius value.

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points. 

 

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with Element 1 trimmed.

These options are only available with the Trimmed 
Circle limitation.
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Bi-tangent and point 
 

●     Select a point or a curve to which the circle is to be 
tangent.

●     Select a Curve and a Point on this curve.

●     Select a Support plane or planar surface.

The point will be projected onto the curve.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

 

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 

Complete circle
For a circular arc, you can choose the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle Complementary trimmed circle

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with both elements trimmed.

These options are only available with the Trimmed 
Circle limitation.
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Tritangent 
 

●     Select three Elements to which the circle is to be 
tangent.

●     Select a Support planar surface.

 If one of the selected inputs is a planar curve, then the 
Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual 
menu is available to clear the selection in order to select 
the desired support.

This automatic support definition saves you from 
performing useless selections.

 
●     Several solutions may be possible, so select the arc 

of circle that you wish to create.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. The first 
and third elements define where the relimitation ends. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two tangent points as end 
points.

  

You can select the Trim Element 1 and Trim Element 
3 check boxes to trim the first element or the third 
element, or both elements.
Here is an example with Element 3 trimmed.

These options are only available with the Trimmed 
Circle limitation.

     
 Center and tangent

 

There are two ways to create a center and tangent 
circle:

 

 

1.  Center curve and radius

●     Select a curve as the Center Element.

●     Select a Tangent Curve.

●     Enter a Radius value.
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 2.  Line tangent to curve definition

●     Select a point as the Center Element.

●     Select a Tangent Curve.

 

 

●     If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired 
support.

This automatic support definition saves you from performing useless selections.

●     The circle center will be located either on the center curve or point and will be tangent to tangent curve.

●     Please note that only full circles can be created.

   

4.  Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
When several solutions are possible, click the Next Solution button to move to another arc of circle, or directly select the arc you 
want in the 3D geometry.

A circle may have several points as center if the selected element is made of various circle arcs with different centers.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.
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Generic Tools
Managing the Compass
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Managing the Compass

This task shows you how to quickly manage the compass orientation.

Create a planar surface.

Press F5 or click the Quick Compass Orientation icon  .

The Quick compass orientation toolbar is 
displayed.

Here are summarized the main features of 
its eight icons:

●     Click the Flip to UV or XY , Flip to VW or YZ  or Flip to WU or XZ  icon to 

switch the compass base to the three planes of its trihedron.

If the compass is "in" the main axes of the model, the icons indicate X, Y and Z 
otherwise U, V and W.

●     Click the Most Seen Plane icon  to activate and deactivate the Most Seen Plane 

mode.

●     Click the Set Compass Orientation icon  or press F6 to orientate the compass by 

selecting either an existing plane or three points (via the Autodetection command).
The point selection is based on Autodetection parameters.

Please refer to the chapter called Editing Curves Using Control Points documentation to 
orientate the compass using control points.

●     Click the Reset Compass to XYZ icon  or press F7 to reset the compass parallel to 

the main axes (X, Y and Z) of the model.
This option is not active when the compass is already set according to the axes.

●     Click the In Model or on Perch icon  to switch the compass from the perch to the 

model or vice versa.
The origin is kept in the model until the toolbar remains open.
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●     Click the Create Compass Plane icon  or press F8 to drop the compass plane, that is 

to create a plane corresponding to the compass basis.
This icon is activated only when the compass is in the model.

These four shortcuts (F5, F6, F7 and F8) are effective only when the Quick compass 
orientation toolbar is displayed. Therefore when you first hit one of the keys, the toolbar is 
displayed and the shortcuts are effective from then on.

The Quick compass orientation toolbar remains active until you close it by clicking the cross in 
the upper-right corner or, if you have activated it with the icon, by clicking the icon again.

By default, elements are created in the current active plane as defined using the Current plane 

orientation toolbar containing the Flip to UV or XY , Flip to VW or YZ   or Flip to 

WU or XZ  icons.
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Workbench Description
This section contains the description of the icons, menus and Historical Graph that are specific to the 
CATIA - Shape Sculptor workbench, which is shown below. 

You can click the hotspots on this image to see the related documentation.
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Menu Bar
Input / Output Toolbar

Component Selection Toolbar
Creation Toolbar
Editing Toolbar

Modeling Toolbar
Analysis Toolbar

Wireframe Toolbar
Generic Tools Toolbar

Specification Tree
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Menu Bar
This section presents the tools and commands which are available in the Shape Sculptor workbench. 
Many other operations are documented in the Infrastructure User's Guide.

Start File Edit View Insert Tools Windows Help

File

The File menu lets you perform file creation, opening saving, printing operations 

Edit 

The Edit menu lets you manipulate selected objects. Refer to the Infrastructure User's Guide and Part 
Design User's Guide. 

View 

The View menu lets you view document contents  Refer to the Infrastructure User's Guide.

Insert 

The Insert menu lets you insert Shape Sculptor's elements.

 For... See...

     

Open body Managing Geometrical Sets

Input/Output Insert -> Input/Output

Component 
Selection 

Insert -> Component Selection

Creation Insert -> Creation

Editing Insert -> Editing

Modeling Insert -> Modeling

Analysis Insert -> Analysis

Wireframe Insert -> Wireframe
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Insert -> Input/Output
 For... See...

Import... Importing Files

Export... Exporting to STL

Insert -> Component Selection
 For... See...

Brush Select...Selecting With a Brush

Curve Select Selecting With Curves

Hole Select Selecting Holes

Flood Select Selecting With Flood

Invert Select Inverting the Selection

Insert -> Creation
 For... See...

Create Curve... Creating 3D Curves

Paint Curve Creating Paint Curves

Generate 
Mesh...

Generating Meshes

Tessellate... Tessellating

Insert -> Editing
 For... See...

Decimate... Decimating

Refine... Refining

Smooth... Smoothing

Brush 
Smooth...

Smoothing With a Brush

Delete 
Triangles

Deleting Triangles

Extract 
Triangles

Extracting Triangles

Copy Triangles Copying Triangles

Slice... Slicing

Mesh 
Intersect...

Intersecting Meshes

Stitch... Stitching
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Insert -> Modeling
 For... See...

Edit Control 
Points...

Editing Curves Using Control Points

Project 
Curve...

Projecting Curves

Curve Sculpt... Sculpting Curves

Emboss... Embossing

Push/Pull... Pushing / Pulling a Mesh

Surface 
Sculpt...

Sculpting With Surfaces

Box Modeling...Modeling Using a Box

Insert -> Analysis
 For... See...

Display 
Options...

Display Options and Graphic Properties

Highlight Analyzing Using Highlights

Insert -> Wireframe
For... See...

Point... Creating Points

Line... Creating Lines

Plane... Creating Planes

Circle... Creating Circles

Window 

The Window  menu lets you arrange document windows in relation one to the other. Refer to the 
Infrastructure User's Guide. 

Help 

The Help menu lets you get help on the currently active command, and the product in general. Refer 
to the Infrastructure User's Guide. 
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Input / Output Toolbar
This toolbar contains the following tools to manage the import and export of polygonal meshes.

  

 

See Importing 
Files

See Exporting 
to STL
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Component Selection Toolbar
This toolbar contains the following tools to manage the selection of triangles on the polygonal mesh.

  

 

See Selecting 
Using a Brush

See Selecting 
Using Curves

See Selecting 
Using a Hole

See Selecting 
Using Flood

See Inverting 
the Selection
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Creation Toolbar
This toolbar contains the following tools to manage the creation of curves and polygonal meshes.

  

 

See Creating 
3D Curves

See Creating 
Paint Curves

See 
Generating 
Meshes

See 
Tessellating
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Editing Toolbar
This toolbar contains the following tools to manage the operations that can be performed on a 
polygonal mesh.

  

 

See 
Decimating

See Refining

See 
Smoothing

See 
Smoothing 
Using a Brush

See Deleting 
Triangles

See Extracting 
Triangles

See Copying 
Triangles

See Slicing

See 
Intersecting 
Meshes

See Stitching
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Modeling Toolbar
This toolbar contains the following tools to model the polygonal mesh.

  

 

See Editing Curves Using 
Control Points

See Projecting Curves

See Sculpting Curves

See Embossing

See Pushing / Pulling a Mesh

See Sculpting Surfaces

See Modeling Using a Box
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Analysis Toolbar
This toolbar contains the following tools to manage the options and graphic properties.

  

 

See Display Options and 
Graphic Properties

See Analyzing Using Highlights
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Wireframe Toolbar
The Wireframe Toolbar contains the following tools:

See Creating Points

See Creating Lines

See Creating Planes

See Creating Circles
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Generic Tools Toolbar
This toolbar contains the following tool to manage the compass.

 

See Managing the Compass
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Specification Tree
Within the Shape Sculptor workbench, you can generate a number of elements that are identified in 
the specification tree by the following icons.

Further information on general symbols in the specification tree are available in Symbols Used in the 
Specification Tree.

3D Curve  Point

Mesh Curve Line

Project Curve  Plane

Mesh Generation Circle

Tessellation   

Stitching   

Polymesh    
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Customizing For Shape Sculptor

This task explains how to customize general settings for the Shape Sculptor workbench.

1.  Select the Tools -> Options menu item.

The Options dialog box is displayed.

2.  Select the Shape category then the Shape Sculptor subcategory to display the 

General tab:

 

 
3.  Check Custom Settings to enable the modification of parameters that control the 

precision of the curves.

4.  Define the Chordal Deviation by entering a value or using the spinners.

5.  Define the Segment Length by entering a value or using the spinners.

6.  Click OK to confirm setting these options.
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Index 

                   

Numerics
3D Curve 

Command   

A
analysis 

highlights  
associative curve 

creating  

B
bisecting 

lines  
bi-tangent and point 

circles  
bi-tangent and radius 

circles  
Bounding box 

Import  
box 

model  
brush 

select  

C
Chordal Deviation 

Decimation  
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Circle 

command  
circles 

bi-tangent and point  

bi-tangent and radius  

point center and radius  

three points  

tri-tangent  

two points  

two points and radius  
Cloud Display 

Cloud Display Options  

command  

Graphic properties  

Polyline and Point  

Sampling  

Triangles  
Cloud Display Options 

Cloud Display  
Command 

3D Curve   
command 

Circle  

Cloud Display  

Control Points  

Current Plane Orientation  

Decimation  

Export  

Import  

line  

plane  

point  

Properties  
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Quick Compass Orientation  
compass 

orientation  
Control Points 

command  
copy 

triangles  
create 

paint curves  
creating 

associative curve  

circles  

circular arcs  
Current Plane Orientation 

command  
Current Triangle Count 

Decimation  
curves 

modifying  

project  

sculpt  

select  

D
decimate 

polymesh  
Decimation 

Chordal Deviation  

command  

Current Triangle Count  

Edge Length  

Free Edge Deviation  

Minimum  
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Target Percentage  

Target Triangle Count  
delete 

triangles  
Delimitors 

Import  
Direction 

Import  

E
Edge Length 

Decimation  

emboss  
Export 

command  

Stl  
extract 

triangles  

F
Facets 

Import  
flood 

select  
Formats 

Import  
Free Edge Deviation 

Decimation  
Free edges 

Import  
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G
generate 

mesh  
Graphic properties 

Cloud Display  
Grouped 

Import  

H
highlights 

analysis  
hole 

select  

I
Import 

Bounding box  

command  

Delimitors  

Direction  

Facets  

Formats  

Free edges  

Grouped  

Minimal point quality  

Statistics  

System  

Update  
intersect 

mesh  
invert 
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select  

L
line 

command  

creating  
lines 

bisecting  

M
mesh 

generate  

intersect  
Minimal point quality 

Import  
Minimum 

Decimation  
model 

box  
modifying 

curves  

O
orientation 

compass  

P
paint curves 

create  
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plane 

command  

creating  
point 

command  

creating  
point center and radius 

circles  
Polyline and Point 

Cloud Display  
polymesh 

decimate  
project 

curves  
Properties 

command  

pull  

push  

Q
Quick Compass Orientation 

command  

R
refine  

S
Sampling 

Cloud Display  
sculpt 

curves  
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surfaces  
select 

brush  

curves  

flood  

hole  

invert  

slice  

smooth   

using a brush  
Statistics 

Import  

stitch  
Stl 

Export  
surfaces 

sculpt  
System 

Import  

T
Target Percentage 

Decimation  
Target Triangle Count 

Decimation  

tessellate  
three points 

circles  
Triangles 

Cloud Display  
triangles 

copy  

delete  
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extract  
tri-tangent 

circles  
two points 

circles  
two points and radius 

circles  

U
Update 

Import  
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